Computer-7
CH-1 NUMBER SYSTEM
Exercise
A. 1. 2, 2. Decimal Number, 3. 8, 4. 10,
5. Binary, 6. Hexadecimal, 7. 0
B. 1. True, 2. True, 3. True, 4. True, 5. False,
6. False.
C. 1. (b), 2. (a), 3. ©, 4. (b), 5. (b)
D. 1. A number system is a set of values used
to represent different quantities.
1.) Decimal Number System, 2.) Binary
System, 3.) Octal Number System
4.) Hexadecimal Number System
5.) Computer Arithmetic
2. Multiply each binary number with its
place value, which is in terms of powers
of 2, starting from the extreme right
digit.
Increase the power one by one, keeping
the base fixed as 2.
Sum up all products to get the decimal
number.
3. The number is borrowed when 1 is
subtracted from 0 (10-1=1).
4. The octal number system (oct)
comprises 8 digits: 0 to 7 with the base
8. The concept of octal number
system came from the Native
Americans as they used to count
numbers by using the space between
their fingers instead of using their
fingers.
5. This number system comprises 16
digits: 0-9 and the letters A-F, where
A-F represents digits 10 to 15 with the
base 16. This number system is also
known as Hex, where Hex=6 and
Decimal = 10, so it is called
Hexadecimal.

number, we have to multiplying the
digits of the number from right hand
side with the increasing power of 8
beginning form 0.
2. The number is borrowed when 1 is
subtracted from 0 (10-1=1).
CH-2 CREATING CHARTS IN MS EXCEL
Exercise
A. 1. Pie, 2. Bar, 3. legend, 4. X-axis,
5. Ribbon,
6. Design, layout and format tabs.
B. 1. True, 2. False, 3. False, 4. False,
5. False, 6. True.
C. 1. (b), 2. (a), 3. (c), 4. (b), 5. (a), 6. (b)
D. 1. (d), 2. (a), 3. (e), 4. (b), 5. (c)

E. 1. X-Axis : It is the horizontal axis of a
chart. It is also known as the category
axis.
Y-Axis : It is the vertical axis of a chart.
It is also known as the value axis.
2. Chart tittle : It contains a summary or
short description to the chart. It is
usually placed at the top of a chart
which helps the users to understand
what the chart represents.
Axis tittle : It is the tittle given to an
axis. A 2D graph has two axes (X, Y)
and a 3D graph has 3 axes (X, Y, Z)
3. 2D chart : A 2D graph has two axes (X, Y)
3D chart : A 3D graph has 3 axes (X, Y, Z).
4. Chart Area : This is the area that makes
up the chart. All charts have a chart
area. This include the plot area and the
space outside it.
Plot Area : It is the rectangular area
bounded by the X-axis define the two
sides of a rectangular plot area.
5. Column Chart : These charts are used
E. 1. Convert any octal number to decimal
to compare values across the different
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categories. Marks obtained in
different subjects by different are
shown through column charts.
Line Chart : The line chart is equally
effective in displaying trends for
multiple series as shown in the figure.
6. Pie chart : A pie chart can only display
one series of the data. If we had
selected multiple series of data. Excel
would ignore all but the first series.
Bar chart : A Bar chart displays
comparisons among individual items
through a group of bars. It is used to
compare multiple values through
horizontal and vertical bars.
7. Area Chart : An area chart are like
line chart except that the area below
the plot line is solid. This chart is
mainly used for representing sales
and production figures of a company.
XY scatter chart : The purpose of a
scatter chart is to observe how the
values of two series compares over
time or other category. The
relationship between two variables is
called correlation.
8. Layout tab : on the layout tab you have
various options to choose from and
select for your chart. You can place
pictures, Shapes, Text boxes, labels or
Background to your chart.
Format tab : You will find several
options to modify the Shape styles,
word art styles or size of the chart.
F. 1. A chart is a graphical representation of
data, in which the data is represented
by symbols such as bars in a bar chart,
lines in a line chart or slices in a pie
chart. A chart can represent tabular
numeric qualitative structure and
provides different information.
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2. Types of Charts
1. Column Chart 2. Line Chart
3. Pie Chart
4. Bar Chart
5. Area Chart
6.XY Scatter Chart
3. A pie chart can only display one
series of the data. Excel uses the
series identified as the identifier as
the chart title and displays the values
for that series as proportional slices
of a pie. Excel would ignore all but
the first series.
4. Select the chart. On the layout tab,
click on the chart title or the data
labels button from the labels group. A
drop-down menu displays. Select the
appropriate option from the dropdown menu. Change the chart title or
the data labels and press the enter
key.
5. First, select the chart, click on the
select data button from the data
group of the design tab of the ribbon.
A select data source dialog box
displays. Do the desired changes in it.
6. Select the chart, click on the copy
button from the clipboard group to
select it. Open the MS Word
document where you want to copy
the chart. Click on the Paste button
from the Clip board group of the
Home tab. You get the copy of the
chart there.
G. Select the cells that comprises the data
you want to use in the chart. Click on the
insert tab of the Ribbon to choose the
type of chart you want to create from the
charts group. A chart of your choice is
created. It is based on the data series. On
clicking the chart different options are
shown in the chart styles group to
choose from.
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CH-3 WORKING WITH FLASH CS6
Exercise
A. 1. Graphic / Adobe Systems, 2. Library,
3. Stage, 4. Work Area, 5. Time line,
6. Layers.
B. 1. True, 2. False, 3. True, 4. True, 5. True
C. 1. (c), 2. (b), 3. (a), 4. (a), 5. (c)

6. Filters enable you to interesting visual
effects to text, buttons and movie clips.
Filters generally include effects, such as
drop shadows, blurs, glows, and bevels,
etc. These effect can be easily applied
using the properties panel.
Animated Filtered Text , Flash furnishes
a unique feature to animate movie clips
that have filters, using motion tweens.
You can make an animation that
involves light source effect, highlights,
bevels and distortions by converting
the filter properties at different
keyframe ad using motion tween.

D. 1. Flash is multimedia graphic program
developed by Adobe Systems (formerly
Macro media). It is used to create
animations, games, cartoons, text,
graphics and other special effects. It
also helps to design movies on the web
and create animations with out using E. 1. Press Ctrl+F8. A convert to symbol
programming skills.
dialog box is appeared give a suitable
2. A gradient is a multicolor fill in which
name to the symbol and click on the
one color gradually turns into another
Graphic option. Click Ok button. The
color. Gradients are created by mixing
symbol is created.
of two or more colors in an objects.
2. Color option to display the color panel.
You can use the color panel to form
v Select either Linear gradient or
your own gradients and add them to
Radial gradient from the color type
the Swatches panel. Two types of
drop-down list.
Gradients 1) Linear Gradient : If
v Double click on the Left Pointer
changes color from the starting point
below the gradient definition bar.
to the end point in a straight line.
The color palette displays. Select
2) Radial Gradient : If changes color
the brown color.
in a circular outward direction,
v Double-click on the right pointer
starting from the focal point.
and select the color.
3. It is used to organize and modify the
v Select the paint bucket tool and
properties of the current selection.
click on the trunk.
4. Select the File
v Adjust the color blends of the
v Import – Import to Stage.
gradient by dragging the pointers
v The Import dialog box displays.
closer to each other or farther apart.
v Browse and select the file that you
v Select any mode like Extend,
want to import and click on Open.
Reflect or Repeat under the Flow
5. Animation includes a series of still
section to apply to the gradient.
images, generally painted or sketched,
v To add more color to your gradient,
appeared in rapid sequence. This
click anywhere on the gradient
transition from one image to another
definitions bar to add a slider
is so quick that it seems to show
(pointer). You can then doublemovement.
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click this slider to set the color.
Flash to create spotlight effect that
would
display the text or object
v Click on the drop-down arrow on
through
a hoke.
the upper right corner of the color
panel bar, and select the Add E. 1. You can lock the layer to avoid any
Swatch from the menu.
further changes to the content added
by you.
CH-4 WORKING WITH LAYERS
Exercise
A. 1. Transparent, 2. Pencil Icon, 3.
4. View, Grid, Show Grid, 5.

CH-5 INTRODUCTION TO HTML 5
Exercise

B. 1. False, 2. True, 3. True, 4. True, 5. False

A. 1. 1. Network, 2. Two, 3. Six, 4. Container,
5. Cascading.

C. 1. (a), 2. (c), 3. (c)

B. 1. True, 2. True, 3. False, 4. True, 5 False.

D. 1. Layers are like sheets of transparent C. 1. (c), 2. (a), 3. (b), 4. (a), 5. (c), 6. (b).
paper arranged in a stack. Each layer is D. 1. HTML stands for Hypertext Mark-up
language. It is a complete code
a separate thing, but when you have a
package that enables the user to create
stack of layers, each with drawings on
web pages that comprise both text
them, they can create an entire scene.
and graphics. It is simple mark-up
2. You can hide the layers to see the
language that expresses the structure
contents on the other layers. While
and behaviors of the web document.
hiding the layers, you have the option
All the web browsers are created to
either to hide all the layers in your
understand and interpret this
document at once or hide the layers
language.
individually.
v Click on the icon above the layers. A

red cross symbol display Eyes in the
Eye column. You will find that all
the contents disappear from the
stage.
v Click on each red cross symbol one
by one in the column, and notice
that the contents on the layer on the
stage.
3. Click on the layer that to be renamed.
v Double click on the layer name and
type the new name.
4. The concept of Masking in Flash CS6
involves using a shapes to hide or
reveal portions of a piece of artwork. It
is like view the outside through a small
window in your house. The window's
size limits what you can see when you
are inside. Masking is generally used in
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2. Container Elements
The elements that consist of both ON
and OFF tags are called Container
Elements.
E.g., <b> This makes the text bold
</b>
Empty Elements
Empty elements include only ON
tags. They do not have OFF tags.
These elements do not enclose any
data; instead they do some function
on their own.
E.g., <br>tag (It breaks the line and
displays the text from the next line.)
3. To create a web page in HTML, follow
the steps given below.
v Open Notepad by clicking on Start
> All apps > Windows Accessories >
Notepad.
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v The Notepad window will display.
v Type the HTML code as shown in

the figure.
v Click on the File > Save option.

The Save As dialog box will
display. Select the target folder to
save the file and mention the
name in File name text box with
an extension .html.
v Click on the Save button to save
your web page.
4. A markup language is a computer
language that uses tags to define
elements within a document. It is
human-readable, meaning marking
files contain standard words, rather
than typical programming syntax.
Originally, HTML was designed with
the intent of defining the structure of
documents to simplify the sharing of
scientific information between
researchers. Now, it is being widely
used to format web pages with the
help of different tags.
5. Cascading style sheets are used to
format the layout of web pages. They
can be used to define text styles table
sizes, and other aspecting web pages
that previously could only be defined
in a page's HTML.
The concrete benefits of CSS include:
v Control layout of many documents
from one single style sheet. (External
Style Sheet).
v More precise control of layout.
v Apply different layout to different
media types (screen, print, etc.)
v More advanced options and
sophisticated techniques.
E. 1. This property is used to add an image
in the background of an HTML
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document.
SYNTAX : background-image:value
where value = url (path of the image)
<html>
<head>
<style type = “text/css”>
body {background-mage:url (“c:/
Users/User/Desktop/Html/Temwork.
png”)}
</style>
2. This property enables us in inserting
the picture or image at a desired place
on the HTML document. By default, a
image is inserted at the top-left corner
of the element.
SYNTAX: background where
value=xpos
ypos|x%y%|[top|center|bottom]||[left|c
enter|right].
CH-6 INTRODUCTION TO QBASIC
Exercise
A. 1. Program, 2. IDE, 3. Statements, 4. 7.1,
5. F5, 6. bar, 7. Mode, 8. Loading, 9. Pixel
10. Sound.
B. 1. False, 2. True, 3. True, 4. True, 5. True,
6. False, 7. True, 8. True, 9. True, 10. False.
C. 1. (b), 2. (a), 3. (b), 4. (a)
D. 1. E= Upper – Right
G= Lower – Left
R= Right
D= Down

H= Upper – Left
F= Lower – Right
L= Left
U= Up

E. 1. Writing Program -Every program in
QBASIC contains statements. Follow
the steps given below to write a
program in QBASIC.
v Click on the File menu.
v Select New Program option.
v Write the program.
SCREEN 2
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LINE (500, 50)-(100, 100
Running Program -To run a program
in QBASIC follow the steps given
below.
v Click on Run Menu.
v Select Start option or type Run in the
Immediate mode of the window.
2. The different steps to save a program in
QBASIC are given below.
v Click on the File menu and Select
Save or Save As option. A Save As
dialog box emerges on the window.
v Type the file name and click on OK
in the dialog box.
Your program is saved with the .BAS
extension. Any file generated in
QBASIC is automatically given an
extension .BAS. This makes it easy to
identify files generated in BASIC.
3. While naming a file follow the rules
given below.
v The file name should not have more
than 8 characters.
v It should start with an alphabet.
v There should be no space in the
name.
v There should be no special characters
in the name.
4. Syntax : PAINT (X, Y), Fill Color,
Border Color
X, Y – The coordinates that show the
location of the shape.
Fill Colour - This is for the colour to be
filled inside the figure. A particular
colour is denoted through a number.
Border Colour - This is for the colour
of the border of the figure. It is also
denoted through a number.
5. The lowest frequency allowed by
QBASIC is 3,7 HZ. The highest
frequency is 32,737 HZ, but this sound
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cannot be heard because the normal
human hearing range ends at 20,000
HZ.
F. DRAW is same as the turtle in the
programming language MSW Logo. With
DRAW, you can move around the screen
and draw lines along the way. Here are the
directional commands given below.
U = Up
D = Down
L = Left
R = Right
E = Upper-right
F = Lower-right
G = Lower-left
H = Upper-left
To drag a cursor without drawing the line,
use the alphabet B before the command.
After each directional command, the
length of the line (pixels) should be
denoted. If no length is defined then the
value is supposed to be 1.
CH-7 WORKING WITH WEB
BROWSERS
Exercise
A. 1. software, 2. Cache, 3. Search,
4. Plug-ins, 5. Image.
B. 1. False, 2. True, 3. True, 4. False, 5. True.
C. 1. (a), 2. (b), 3. (a), 4. (c), 5. (c), 6. (c).
D. 1. Graphical Web Browser : Graphical
browser like Internet Explorer,
Mozilla Firefox, Netscape, Opera and
Google Chrome can display text,
images, audio and video files. They
are accessible for operating systems
such as Windows, Apple and Linux.
You can even download and install a
graphical browser on your computer.
Text Web Browser: A text web browser
like a graphical browser, Lets you surf
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the web. However, there is one big
difference the complete absence of a
nice Looking interface. You hardly ever
use the mouse to more about but rather
employ keys like the tab and the enter
key. opening a web site shows you only
text.
2. Links : A link is an HTML object that
allows you to jump to a new location
when you click or tap it. links are found
on almost every web page and provide
a simple means of navigating between
pages on the web. It can be text or an
image. Sometimes you are not sure if it
is a link or not. Place the cursor over it
if it turns to a hand symbol then it is a
link.

Your browser may have come with
some plug-ins already installed. Once
you have the necessary plug-ins, you
will be able to enjoy watching videos
and playing games on web sites.
4. Internet Explorer: Internet Explorer is
a web browser that allows computer
users to view web pages on the Internet
users can also use Internet Explorer to
listen and watch streaming content,
access online banking, make purchases
over the Internet and much more.
Internet Explorer was first introduced
in August 16, 1995 by Microsoft as
Internet Explorer 1.0. So far 11 versions
of Internet Explorer were released.
Internet Explorer 11. Which was
released in 2013, is the last version of
the web browser.

Bookmarks : Bookmarks is an Internet
browser feature that allows a user to go
Google Chrome: Google Chrome is
back to a previously visited website by
yet another popular web browser that
clicking on the saved link- without
was developed by Google. It was
retyping the site's address. It is also
released on December 11, 2008. It
called favorites. In Internet Explorer,
allows the users to quickly access web
you can add a bookmark by clicking
pages and make local desktop shortcuts
Favorites and then Add to Favorites.
to open the web application in the
You can also click on Bookmarks and
browser. Google Chrome is extensively
select Save this page option to save the
used by the users due to its stability and
web page. Other browsers are similar,
simplicity.
but they may use different names for
book marking.
E. 1. A web browser or frequently called as
browser is an application software that
3. Hyperlinks : A hyperlink is an element
is installed on a computer to provide
in an HTML document that links to
access to the World Wide Web. It brings
either another portion of the
the Web pages from the servers along
document or to another document
with the necessary files such as images,
altogether. On webpages, hyperlinks
Hashes, videos etc. interprets them and
are usually colored purple or blue and
then displays it on the serves. Example:
are sometimes underlined.
internet explorer, chrome, safari etc.
Plug-ins : Plug-ins applications are
2. Some popular web browsers are
program that can easily be installed
Internet Explorer, Mozilla Firefox,
and used as part if your web browser.
Google Chrome, Safari and Opera.
E xamples of plug-ins include
QuickTime Player and Flash player.
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Internet Explorer: Internet Explorer is
a web browser that allows computer
users to view web pages on the Internet
users can also use Internet Explorer to
listen to and watch streaming content,
access online banking, make purchases
over the Internet and much more.
Internet Explorer was first introduced
in August 16, 1995 by Microsoft as
Internet Explorer 1.0. So far 11 versions
of Internet Explorer were released.
Internet Explorer 11. Which was
released in 2013, is the last version of
the web browser.
Google Chrome: Google Chrome is
yet another popular web browser that
was developed by Google. It was
released on December 11, 2008. It
allows the users to quickly access web
pages and make local desktop
shortcuts to open the web application
in the browser. Google Chrome is
extensively used by the users due to its
stability and simplicity.
3. There are mainly two types of
browsers- Graphical and Text.
Graphical Web Browser : Graphical
browser like Internet Explorer, Mozilla
Firefox, Netscape, Opera and Google
Chrome can display text, images, audio
and video files. They are accessible for
operating systems such as Windows,
Apple and Linux. You can even
download and install a graphical
browser on your computer.

key. opening a web site shows you only
text. In Short 'A text web browser
displays only the text on a web sites
with any links. It cannot display any
images, video or flash animations.
Gopher is the popular text web
browser.
4. A search engine is a software program
available through the Internet that
helps you to search specific
information. Today there are
thousands of different search engines
available on the Internet each with
their own abilities. These search
engines are software on the web that
help you to search specific
information. The result that you get is
a list of links that match with the
keywords Search engines vary in the
way they find and list the content on
the web.
Today the most popular and wellknown search engine is Google. Other
popular search engines include
Ask.com, Yahoo, Rediff, AOL, and
Baidu.
5. Bookmarks is an Internet browser
feature that allows a user to go back to a
previously visited website by clicking
on the saved link- without retyping the
site's address. It is also called favorites.
In Internet Explorer, you can add a
bookmark by clicking Favorites and
then Add to Favorites. You can also
click on Bookmarks and select Save this
page option to save the web page. Other
browsers are similar, but they may use
different names for book marking.

Text Web Browser: A text web browser
like a graphical browser, Lets you surf
the web. However, there is one big
difference the complete absence of a F. 1. We should not click on the irrelevant
links or advertisements on a web page
nice Looking interface. You hardly ever
while browsing. Given below the
use the mouse to more about but rather
harmful effects of irrelevant links:
employ keys like the tab and the enter
Keys Computer (6-8)
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v Hacking your website.
v Building hundreds or thousands of

spammy links to your website.
v Copying your content and distributing

it all over the internet.
v Pointing vulgar links to your website.
v Creating fake social profiles and

ruining your reputation online.
2. When you use the and buttons your
browser may use its web Back
Forward cache to display the page.
The web cache stores lately viewed
web pages so that they do not need to
be downloaded again. You can use the
Refresh button (sometimes called
Reload) to tell the browser to load the
page again.
CH-8 INTRODUCTION TO E-MAIL
Exercise
A. 1. Server, 2. G mail and Yahoo, 3. E-mail,
4. Bcc, 5. Domain.
B. 1. True, 2. False, 3. True, 4. True, 5. True,
6. True, 7. True.
C. 1. (a), 2. (b), 3. (c), 4. (b), 5. (b), 6. (a).
D. 1. Email or electronic mail is a way to
send or respective messages through
the Internet. E-mail is very fast, usually
taking only a few seconds to reach its
destination.
2. v Click on the Attach option in the New
Message box. An Insert Attachment
dialog box appears.
v Find and select the files you want to
attach, and then click on Attach.
Perform this step for each file you
want to add.
v The attached file information
display in the New Message box.
v Click on the Send button after
typing the e-mail address of the sent
message is started in the Sent folder.
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3. On successfully logging into an email
account, several options such as Inbox,
Drafts, Compose and Sent Mail are
visible on the screen.
4. Netiquette or net etiquette refers to
etiquette on the Internet. Good
netquette involves respecting other
privacy and doing anything online that
will annoy or frustrate other people.
5. Some of the websites that provide free
e-mail accounts are www.gmail.com,
www.yahoomail.com
and www.hotmail.com
v Connect to the internet by doubleclicking the internet explorer or the
google chrome.
v Type gmail.com in the address bar
and go to Gmail site.
v Click on the link Create an account
present at the bottom.
v A form will appear on the screen.
Fill in the information that has been
asked for like your name, date of
birth, e-mails address you prefer or
password. Be very careful while
your password. Memorize it and
keep changing the password
periodically to maintain the
security of password.
v There is a section in the form that
includes security questions which
makes it possible for you to retrieve
the password in case you forget it.
The question that you choose to
answer in the form is asked by
Google to verify your identify.
v In the next section of the form, you
have to type the code in the box to
security reasons.
v Finally you have to agree to the
Terms of Service. After reading the
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text properly click on I Agree.
v After filling the form and agreeing
to the terms and conditions, your email account is created and you
receive a new e-mail address and a
password.
6. A blog is also known as weblog. It is a
personal online diary or for can say
journal which allows you to share
thoughts are ideas. You can add video,
games, pictures music. You can do all
there things without the need of any
programming knowledge.
v Blogging is the act of posting
content on a blog or posting
comments on someone else's blog.
v Blogging is very popular today
because it allows people to
interact with each other. Blogging
has also become a popular search
engine optimization tool because
search engines like Google and
Yahoo know that a blog is
frequenly updated with content in
visitor comments.
v Sometimes blogging can also be
used as actual media that spreads
news. There has been more than
one occasion where a major
newspaper decided to run only a
small article about something that
lots of people would consider big
news.
v There are many different types of
blogs like personal blogs,
corporate and organizational
blogs are interactive, allowing
visitors to leave comments to a
bloggers postings.

spam from the same source, complain
to your Internet service provider.
2. No, it consequences very bad.
CH-9 COMPUTER VIRUSES
Exercise
A. 1. Antivirus, 2. Virus, 3. Trojans,
4. Worm, 5. Hardware.
B. 1. False, 2. False, 3. False, 4. True, 5. False,
6. True, 7. True, 8. False.
C. 1. (b), 2. (a), 3. (b), 4. (b), 5. (a), 6. (c),
7. (a).

D. 1. Technically, a computer virus is a type
of ill-natured code or program written
to after the way a computer operators
and that is designed to spread from one
computer to another. A virus operates
by inserting or attaching itself to a valid
program or a document that supports
macros on order to carry out its code.
In the process a virus has the potential
to cause damaging effects. Such as
harming the system software by
corrupting or destroying data.
2. A computer virus carries out the
following actions.
v It can infect the executable
program files like Microsoft Word
and operating system programs.
v It can infect the file before it is
attached to an e-mail message or
transferred to a disk.
Thus, the virus spreads from one
computer to another.
3. Computer viruses generally spread in
one of the three ways:
v From removable media,
v From files downloaded from the
Internet and
F. 1. Spam filters can help, but they are not
v From e-mail attachments.
error-free. If you are receiving lots of
4. Antivirus software is an application
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software developed to detect and
remove the virus from the computer
system. Whenever the computer
system is started antivirus starts
automatically. It detects the virus in
all the directories and files of
computer system. When the virus is
detected, it removes that virus. Some
popular antivirus software are given
below.
v Norton AVG † Avast † McAfee †
Symantec
v Kaspersky (It is well-known for its
high detection rate.) † SmartDog
5. Most viruses are developed to avoid
detection by the computer user. But
there are a few signs that denote the
existence of a virus in our computer.
v The computer starts to operate
slower than normal.
v The computer does not respond to our
instruction and shuts down frequently.
v The computer generally restarts on
its own.
v Applications we store in the
computer do not work as usual.
v Some or the whole part of disk
drives becomes difficult to access.
v Strange error messages might
display on the screen.
v A virus-infected file will have double
extensions like image.jpg.vbs or
image.jpg.exe.
v Strange icons emerge on our
desktop that are not associated with
to any program.
6. To prevent viruses from entering our
computer, we must update information
about existing viruses in the antivirus
program. We should careful while
browsing the internet, downloading
42

files or open an email attachment. By
doing these things, we can keep our
computer free from harmful virus
programs. Some preventive measures
are given.
v Obstruct access of viruses to your
system both offline and online.
v Allow only authentic users to use
your system.
v Keep programs and data on
separate disks, if possible.
v Scan all the pen drives and CDs
with the antivirus software before
using them.
v Make sure that the latest version of
an antivirus software is installed in
your computer.
E. 1. It can enter the computer through an
infected floppy, CD, pen drive or the
internet. It can attach itself to an item in
the computer system.
Most viruses stay active in the
computer memory until for turn off the
computer.
Scan all the pen drives and CDs with
the antivirus software before using
them.
CH-10 CYBER THREATS & SECURITY
Exercise
A. 1. Spoof, 2. Cyber Bullying, 3. Pharming,
4. Hacking, 5. Biometrics.
B. 1. False, 2. True, 3. True, 4. True, 5. True,
6. True, 7. False, 8. False, 9. False.
C. 1. (c), 2. (b), 3. (b), 4. (a), 5.
D. 1. Computer and Internet have become an
integral parts of our life. The fast
growing technologies of the modern
age have made our life much easier and
more connected around the globe
through interconnected networks.
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Today we are connected to the
Internet through computer, smart
phone or tablet. These devices are
used for storing personal information,
online banking, online shopping,
bookings tickets, playing games, and
connecting with friends over social
media.
Although networks of today have made
the communication process very easy
and have provided great opportunities
in almost all spheres, yet there are
various kinds of challenges and threats
related to the use of these networks of
today. These threats are called
Cybercrimes.
2. A Cyber crime is any unlawful activity
done through Internet such as identity
theft; where somebody can steal your
e-mail Id or password and use it to send
fake emails to people comprising false
information about the product or
winning a lottery etc.
Then there are credit card account
thefts, Internet frauds such as
purchasing goods in your name,
fishing out mobile phone contacts etc.,
forgery i.e., parroting documents,
currency and objects of other people
with bad purposes harassing others
and mischief mongering, by sending
threatening messages, all of which
come under the jurisdiction of Indian
Penal Code (IPC).
Cybercrimes can be divided into three
main groups.
v Crime against an Individual person
v Crime against property
v Crime against an organization/society
3. CYBER STALKING
In cyber stalking the person can:
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v Harass and humiliate the victim by

posting false information about
him.
v Monitor or view a victim's online
activities.
v Damage the victim's computer by
sending viruses.
v Threaten the victim or his family.
v Order humiliating items or subscribe
cheap magazines and deliver these at
victim's house or workplace.
CYBER BULLYING
It is an act of harming or harassing
through information technology in an
intentional manner. This involves
insulting remarks and threating
messages sent by e-mails spreading
rumors about the person either by emails or social networking sites,
posting shameful photos and videos to
hurt the person, offensive remarks
against gender, race, religion, or
nationality.
4. Phishing is a form of Freud in which an
attacker masquerades as a reputable
entity or person in email or other
communication channels. The user is
asked to visit a websites in which he is
asked to update or validate his personal
details, like user name, password, credit
card details, etc. In this way the operators
of the fake websites perpetrate crimes in
your name after stealing your identity.
5. Procuring or stealing someone's
personal information is called Identity
theft. It is a major issue for people who
use Internet for online shopping, cash
transactions, and banking services.
The stolen information generally
includes a person' name, date of birth,
account number, credit/debit card
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information is then misused to acquire
genuine documents, new credit cards
to make purchase, withdraw money,
get passports and driving licences in
the victims name. Hackers steal the
information either through hacking
the network that a person is connected
to or placing a software unknowingly
on a person's computer.
6. A password is a sequence of characters,
such as letters, numbers and symbols
used as secret key for accessing a
computer system or network. It
guarantees that the system is accessed
only by the authorized users. To protect
data and important information,
strong passwords should be used.
7. In computer terminology, backup
refers to the process of making copies
of data or data files to use in the event
the original data files are lost or
destroyed. These additional copies are
called backups. Backups can also be
used to restore the files that have been
deleted accidentally or corrupted by
the virus.
8. Firewall is a security system that
protects your computer by preventing
unauthorized users from acquiring
access to it through network or
internet. It can either be hardware or
software or a combination of both. It is
enacted on the gateway of a network
and follows a particular set of rules
defined by the user or the network
administrator. Based on these rules, it
checks the incoming and outgoing
network traffic.
E. 1. ENCRYPTION SOFTWARE
While transferring data over
networks, we may lose data privacy.
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We can protect our data from
unauthorized access by using the
technique called Encryption.
Encryption is the process of
converting information or data into a
code, especially to prevent
unauthorized access. Encryption
software is used to create the
encrypted text called 'Cipher text'. To
read an encrypted message, it has to
be decrypted with the same software
on the receivers's side. This process is
called Decryption. The software
applications, like GnuPg can be
applied to encrypt data files and Emails.
2. CYBER BULLYING
It is an act of harming or harassing
through information technology in an
intentional manner. This involves
insulting remarks and threating
messages sent by e-mails spreading
rumors about the person either by emails or social networking sites,
posting shameful photos and videos to
hurt the person, offensive remarks
against gender, race, religion, or
nationality.
MODEL TEST PAPER-1
A. 1. (c), 2. (c), 3. (a), 4. (b), 5. (b)
B. 1. Hexodecimal, 2. 0, 3. Design, Layout
and Format tabs, 4. Timeline, 5. Layers
C. 1. True, 2. True, 3. False, 4. True, 5. True
D. 1. The number is borrowed when 1 is
subtracted from 0 (10-1=1).
2. 2D chart : A 2D graph has two axes (X,
Y)
3D chart : A 3D graph has 3 axes (X, Y,
Z).
3. Select the File
v Import – Import to Stage.
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v The Import dialog box displays.
v Browse and select the file that you

want to import and click on Open.
4. X-Axis : It is the horizontal axis of a
chart. It is also known as the category
axis.
Y-Axis : It is the vertical axis of a chart.
It is also known as the category axis.
5. It is used to organise and modify the
properties of the current selection.

movie or animation when required.
Symbols can be graphics buttons or
movie chips. These are very useful
elements.
Model Test Paper-2
A. 1. (b), 2. (b), 3. (a), 4. (c), 5. (c)
B. 1. View, Grid, Show Grid 2. Two, 3.
Sound, 4. Transparent, 5. Cascading
C. 1. False, 2. True, 3. True, 4. True, 5. False
D. 1. You can hide the layers to see the
contents on the other layers. While
hiding the layers, you have the option
either to hide all the layers in your
document at once or hide the layers
individually.
v Click on the icon above the layers. A
red cross symbol display Eye s in the
Eye column. You will find that all
the contents disappear from the
stage.
v Click on each red cross symbol one
by one in the column, and notice
that the contents on the layer on the
stage.

5. 1. Machine Language: a computer
programming language consisting of
binary or hexadecimal instructions
which a computer can respond to
directly.
2. MS Excel Bar: The menu bar is the part
of a browser or application window,
typically at the top left side, that houses
drop-down menus that allow the user
to interact with the content or
application in various ways. In
Microsoft Word, for example, the
"File" menu provides options to open a
file, create a new one, and save or print
-- among others. The "Edit" menu
2. . Writing Program -Every program
allows the user to perform such
in QBASIC contains statements.
functions as copying and pasting,
Follow the steps given below to
finding and replacing text.
write a program in QBASIC.
3. Gradient: A gradient is multicolor fill
v Click on the File menu.
in which one colour gradually turns in
v Select New Program option.
another colour. Gradients a created by
v Write the program.
mixing of two or more colours in an
SCREEN 2
object. You can use the colour panel to
LINE (500, 50)-(100, 100
form your own gradients and add to
Ÿ
Running
Program -To run a program
form your own Swatches panel.
in
QBASIC
follow the steps given
4. Rotation Handle: You can move the
below.
rotation handle clockwise or anticlockwise
Ÿ
v Click on Run Menu.
to rotate the gradient as needed.
v Select Start option or type Run in
5. Symbols: A Symbol is a name for any Ÿ
the Immediate mode of the
object created by the user and is stored
window.
in the library. It can be used to add to a
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3. Container Elements
The elements that consist of both ON
and OFF tags are called Container
Elements.
E.g., <b> This makes the text bold </b>

font size or color. All attributes contain
two parts a name and a value. The
'name' is the characteristic that you
want to set and the 'value' is what you
want for the specific characteristic.
2.
Markup
Language: A markup language
Empty Elements
is
a
computer
language that uses tags to
Empty elements include only ON tags.
define
elements
within a document. It
They do not have OFF tags. These
is
human-readable,
meaning marking
elements do not enclose any data;
files
contain
standard
words, rather
instead they do some function on their
than
typical
programming
syntax.
own.
3.
QBASIC:
QBASIC
is
one
of
the versions
E.g., <br>tag (It breaks the line and
of
BASIC.
It
refers
to
Quick
Beginners
displays the text from the next line.)
All purposes Symbolic Instruction
4. Writing Program -Every program in
Code.
QBASIC contains statements. Follow
4. Link Break Element: Link break
the steps given below to write a
element separates the line and shows
program in QBASIC.
the text on a new line. It is like an Enter
v Click on the File menu.
key on a keyboard which takes the
v Select New Program option.
cursor on the next lie towards the left
v Write the program.
margin on the screen. Line breaks are
SCREEN 2
good for ending lines after short pieces
LINE (500, 50)-(100, 100
of information such as address.
Running Program -To run a program
5. Masking In Flash : The concept of
in QBASIC follow the steps given
masking in Flash CS6 involves using a
below.
shapes to hide or reveal portions of a
v Click on Run Menu.
piece of art work. It is like view the
outside through a small window in
v Select Start option or type Run in
your house. The window's size limits
the Immediate mode of the
what you can see when you are inside.
window.
Masking is generally used in Flash to
5. The concept of masking in Flash CS6
create spotlight effect that would
involves using a shapes to hide or reveal
display the text or object through a
portions of a piece of art work. It is like
hoke.
view the outside through a small
Model Test Paper-3
window in your house. The window's
size limits what you can see when you A. 1. (a), 2. (a), 3. (c), 4. (a), 5. (a)
are inside. Masking is generally used in B. 1. Search, 2. Server, 3. Worm, 4. Hacking,
Flash to create spotlight effect that
5. Biometrics
would display the text or object C. 1. True, 2. True, 3. True, 4. True, 5. True
through a hoke.
D. 1. Graphical Web Browser : Graphical
E. 1. Attribute: In HTML an attribute is a
browser like Internet Explorer, Mozilla
characteristic of page elements, such as
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Firefox, Netscape, Opera and Google
Chrome can display text, images, audio
and video files. They are accessible for
operating systems such as Windows,
Apple and Linux. You can even
download and install a graphical
browser on your computer.

5. Computer viruses generally spread in
one of the three ways:
v From removable media,
v From files downloaded from the
Internet and
v From e-mail attachments.
E. 1. Domain: A group of computers and
Text Web Browser: A text web browser
devices on a network that are
like a graphical browser, Lets you surf
administered as a unit with common
the web. However, there is one big
rules and procedures. Within the
difference the complete absence of a
Internet, domains are defined by the IP
nice Looking interface. You hardly ever
address. All devices sharing a common
use the mouse to more about but rather
part of the IP address are said to be in
employ keys like the tab and the enter
the same domain.
key. opening a web site shows you only
2. Viruses: Technically, a computer virus
text.
is a type of ill-natured code or program
2. v Click on the Attach option in the
written to after the way a computer
New Message box. An Insert
operators and that is designed to
Attachment dialog box appears.
spread from one computer to another.
v Find and select the files your want
3. Links: A link is an HTML object that
to attach, and then click on Attach.
allows you to jump to a new location
Perform this step for each file you
when you click or trap it. Links are
want to add.
found on almost every webpage and
v The attached file information
provide on the web. It can be text or an
display in the New Message box.
image.
v Click on the Send button after
4. Navigation Buttons: Sometimes, when
typing the e-mail address of the
you click on a link, you may need go
sent message is started in the Sent
back to the previous page. It can be
folder.
done by using browser's Back button.
3. Netiquette or net etiquette refers to
Once you have pressed the Back
etiquette on the Internet. Good
button, you can press the Forward
netquette involves respecting other
button to the follow the link again.
privacy and doing anything online that
5. Website: A set of interconnected
will annoy or frustrate other people.
webpages, usually including a homepage,
4. In computer terminology, backup refers
generally located on the same server, and
to the process of making copies of data
prepared and maintained as a collection
or data files to use in the event the
of information by a person, group, or
original data files are lost or destroyed.
organization.
These additional copies are called
backups. Backups can also be used to
restore the files that have been deleted
accidentally or corrupted by the virus.
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